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ВВЕДЕНИЕ 

Курсы «Техника и технология рекламы» и «Рекламные технологии» 

относятся к группе специальных дисциплин для студентов дизайнерских 

специальностей. В данных методических указаниях студенты и слушатели 

получают информацию о технике и  основных технологических приемах 

создания, верстки полиграфической продукции, овладевают навыками 

индивидуальной настройки интерфейса среды разработки, приобретают  

методические и практические навыки при разработке и проектировании 

различных объектов полиграфической продукции. 

Графическая разработка дизайнерского решения и верстка веб-сайтов 

является важным аспектом формирования творческой личности дизайнера на 

заключительном этапе обучения, что готовит его к использованию 

существующих достижений в области технологической подготовки. В данных 

методических указаниях приведены некоторые аспекты общей 

последовательности разработки полиграфической продукции на примере 

буклета, даны рекомендации по применению функциональных возможностей 

программы, их  возможности. Методические указания помогут  сформировать у 

студентов и слушателей умение ориентироваться в современных 

компьютерных технологиях, позволяющих создавать эскизную часть проектов 

и производить обработку изображений и текстовых фреймов, а также 

технологическое обеспечение дизайна и производства печатной продукции, 

web-страниц, дать практические навыки работы с профессиональной 

компьютерной издательской системой QuarkXPress. 

QuarkXPress – программа компьютерного макетирования и верстки газет, 

журналов, книг, брошюр, рекламных листков и прочих графических 

материалов. Вместе с Adobe Illustrator и Adobe Photoshop QuarkXPress 

составляет основу профессиональной системы компьютерной верстки, 

используемой в издательствах, рекламных и маркетинговых агентствах, 

дизайнерских фирмах и типографиях. Ввиду больших функциональных 

возможностей программных продуктов, существуют альтернативные способы 

решения поставленных задач, поэтому в данных методических указаниях 

представлены базовые технологические приемы, применяемые при 

современной разработке  и верстке типографской продукции. 

1 Работа со средой QuarkXPress на начальном этапе 

Основы работы со средой QuarkXPress 

ВАЖНО! Для лучшей оптимизации файла верстки рекомендуется 

отказаться от использования файлов TIFF в слоях, заменяя их файлами 

TIFF без слоев. 

При наведении курсора, как и в других программных продуктах, 

«всплывает» подсказка  параметра. 
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В данных методических указаниях используется частичное чередование 

представлений рисунков англоязычной и русскоязычных версий, которые 

интуитивно совместимы для лучшего овладения программой при дальнейшем 

использовании в творческой работе. 

Основными составляющими интерфейса QuarkXPress являются Главное 

меню, многие команды которого знакомы и не требуют пояснений, Палитры, 

устанавливаемые через меню Окно (Window), и панели Инструментов (Tools), 

управление которыми за счет информативности иконок осуществляется 

интуитивно. Запустите программу (рис. 1.1). 

 

 

 

Рисунок 1.1 ― Интерфейс программы 

 

Одним из основных способов работы с программой является  

использование панели Инструментов (Tools) (рис. 1.2). 

 

 

 

Рисунок 1.2 ― Панель Инструментов (Tools) 

 

1. Элемент (Item Tool) – для выбора, перемещения, изменения размеров и 

формы, поворота, удаления, вырезания, копирования и вставки элементов. 
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2. Текстовое содержимое (Text Content Tool) – для рисования текстовых 

блоков и работы с текстом. 

3. Содержание рисунка (Picture Content Tool) – для рисования графических 

блоков и работы с рисунками. 

4. Инструменты создания блоков (Rectangle Content Tool). 

5. Линия (Line Tool) – для создания прямых линий любого наклона. 

6. Перо Безье (Bezier Pen Tool) – для создания линий и блоков Безье.  

7. Таблицы (Table Tool) – для создания таблиц. 

8. Масштаб (Zoom Tool) – для увеличения/уменьшения макета на экране. 

Для создания собственного проекта выполните следующие действия. 

Выберите команду File>New>Project (Файл>Создать/Новый>Проект) (рис. 

1.3).  
 

 

 

 

Рисунок 1.3 ― Вид интерфейса при создании нового проекта 

 

В следующем окне вам следует выбрать целый ряд параметров: название, 

тип макета, размеры страницы и т. д. Кроме того, можно указать 

необходимость автоматического создания текстового блока, количество 

колонок текста на странице, а также значения полей (рис. 1.4). 
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Рисунок 1.4 ― Выбор параметров проекта 

 

2 Работа с текстом 

 

Установка колонок 

 

Выполняем команду File>New>Project (Файл>Создать/Новый> 

Проект). Появится окно параметров нового документа (см. рис. 1.3). В поле 

Columns (Колонки) можно указать количество колонок (см. рис. 1.4). 

Нажимаем <ОК>. После того как число колонок установлено, его можно 

изменить, для этого в палитре Page Layout (Макет страницы) сделайте 

двойной щелчок мышки по A-Master (Управление страницей). После этого в 

меню Page (Страница) выберите Master Guides & Grid…(Управление 

колонками и сеткой) (рис. 2.1). 

Витебский государственный технологический университет
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Рисунок 2.1 ― Вид интерфейса при установке колонок 
 

Здесь точно также нужно установить значения (количество колонок) в 

поле  Columns (Колонки) и нажать <ОК> (рис. 2.2). 

 

 

 

Рисунок 2.2 ― Вид интерфейса при установке колонок 
 

Чтобы вернуться обратно на рабочую страницу, нужно сделать двойной 

щелчок в названии страницы в панели Page Layout (Макет страницы). 
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Создание текстового фрейма 

С помощью инструмента Text Content Tool (Текстовое содержимое) 

задайте страницы текстового блока, растянув курсором по рабочей области, и 

отпустите кнопку мыши (рис. 2.3). 

 

 
 

Рисунок 2.3 ― Вид интерфейса при создании текстового блока 
 

Теперь в эту выделенную маркерами область можно вписывать текст, 

изменять его размеры. Можно переместить текст с помощью инструмента Item 

Tool (Элемент) (рис. 2.4). 

 

 
 

Рисунок 2.4 ― Вид интерфейса при перемещении текста 
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Ввод и форматирование текста 
 

Для того чтобы отформатировать текст, нужно его выделить. Работа 

производится в панели Measurements (Измерения). В поле ввода с 

обозначением угла указывается поворот текстового блока относительно 

горизонтального положения (рис. 2.5). 
 

 
 

Рисунок 2.5 ― Вид интерфейса при повороте текста 

 

В поле Columns (Колонки) указывается количество колонок текста.  При 

наведении курсора «всплывает» подсказка параметра Интерлиньяж (Leading), 

указывает на расстояние между строками, также можно задать в Kern 

(Кернинг) Track Amount (Межсимвольное расстояние) расстояния между 

символами (рис. 2.6). 

 

 
 

Рисунок 2.6 ― Вид интерфейса при изменении параметров текста 
 

Более подробно настройки  параметров текста в п. Керниг и трекинг. 
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Настройки текстового фрейма 

 

Выполните команду Item>Modify (Элемент>Изменить). В закладке Text 

(Текст) вводится в первом поле угол поворота текста, во втором − угол наклона 

и в третьем − число колонок. В следующем поле − расстояние между 

колонками. В следующем разделе представлен список минимум, в нем имеется 

3 способа задания базовой линии текста А по высоте основного документа, 

С+А − по высоте заглавного символа, СН − по интерлиньяжу. В поле Offset 

(Смещение) вводится значение высоты базовой линии фрейма (рис. 2.7). 

 

 
 

Рисунок 2.7 ― Вид интерфейса при настройках текстового фрейма 

 

Сцепление текстовых блоков 

 

Для этого нужно создать 2 прямоугольных фрейма с помощью 

инструмента Text Content Tool (Текстовое содержимое) (рис. 2.8). 
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Рисунок 2.8 ― Вид интерфейса при сцеплении текстовых блоков 
 

Удерживайте кнопку Text Content Tool (Текстовое содержимое) и 

выберите Text Linking Tool (Инструмент связывания текста). Этим 

инструментом сначала нажмите на первый фрейм, потом на второй, 2 фрейма 

будут сцеплены (рис. 2.9). 

 

  
 

Рисунок 2.9 ― Вид интерфейса при перетекании текстовых блоков 

Витебский государственный технологический университет
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Когда вы будете писать текст во фрейме, он перетечет во второй фрейм, 

если ему не хватит места в первом. 

 

Работа с абзацами 

 

Характеристики абзаца задаются в палитре Edit>Style Sheets 

(Редактировать>Таблицы стилей). При установке параметров в палитре, они 

будут действовать только на выделенный фрейм, или на котором установлен 

курсор. Изначально по умолчанию стоит только 2 вида текстового стиля, 

поэтому нужно создать новый, щелкаем правой кнопкой мыши по No style (Нет 

стиля), выбираем New (Создать/Новый). Появляется окно, в котором 

происходит вся установка настроек абзацев (рис. 2.10).  
 

 
 

Рисунок 2.10 ― Вид интерфейса при установке настроек абзацев 
 

В закладке Formats (Форматы) в первом и третьем поле задаются 

отступы абзаца от вертикального текстового фрейма, во втором − отступ 

первой строки, в 5, 6 − задаются отбивки (расстояния между соседними 

абзацами). Включатель Lock to Grid (Привязать к сетке) представляет собой 

включение привязки не только по базовым линиям документа, но и по базовым 

линиям текстового блока (рис. 2.11). 
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Рисунок 2.11 ― Вид интерфейса при дополнении настроек абзацев 

 

Отбивка абзаца линейками 

 

Щелкаем правой кнопкой мыши по No style (Нет стиля), выбираем New 

(Новый). Далее на вкладке Rules (Направляющие линии) (рис. 2.12). 

 

 
 

Рисунок 2.12 ― Вид интерфейса при настройке линий абзацев 
 

Первая группа параметров относится к проводимым линиям, Над (Above) 

абзацем, вторая, Под (Below). Установите на обоих флажок для открытия 
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параметров. В первом поле задается длина линии, во 2 и 3 создается отступ в 

пунктах слева и справа, 4 отвечает за отступ от верхних границ текстового 

фрейма. Далее выбирается линия в списке Style (Стиль) (рис. 2.13).  
 

 
 

Рисунок 2.13 ― Вид интерфейса при дополнении настроек линий абзацев 
 

В следующем списке создается толщина разделительной линии, в 

следующем − цвет, следующая − яркость линии, следующая − прозрачность. 

После установки нажмите <ОК>. Появится созданный вами стиль в палитре 

Style Sheets (Таблицы стилей). Выделите текст и щелкните по названию стиля 

в панели. 

 

Расположение текста вдоль объекта 

 

Создадим произвольный контур с помощь инструмента Pen Tool 

(Инструмент Перо). Дважды щелкаем по нему инструментом Text Content 

Tool (Текстовое содержимое) и курсор текста будет помещен на нем. Можно 

поменять выравнивание абзаца, тогда изменится положение курсора (рис. 2.14).  
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Рисунок 2.14 ― Расположение текста по произвольному контуру 
 

После того как разместили текст на контуре, можно менять положение 

контура, для этого нужно выбрать инструмент Item Tool (Элемент). Сжимайте 

или растягивайте линию контура (рис. 2.15). 

 

 
 

Рисунок 2.15 ― Редактирование произвольного контура с текстом 
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Настройка объектов «контур с текстом» 

 

Рассмотрим параметры регулировки контура с текстом. Выделяем контур, 

выбираем команду Item>Modify (Элемент>Изменить) (рис. 2.16). 
 

 
 

Рисунок 2.16 ― Редактирование контура текста относительно линии 
 

Закладка Text Path (Вид текста) определяет вид текста над линией. В 

поле Text Alignment (Выравнивание текста) устанавливается расположение 

текста относительно линии контура. Descent – текст располагается над линией, 

Center – линия контура находится в центре строки (при этом лучше сделать 

контур невидимым, так как текст будет перечеркнут), Baseline – 

непосредственно на линии, Ascent – текст располагается под линией контура. 

Flip Text − текст будет зеркально отражен относительно линии. В закладке 

Line (Линия) можно выбрать настройки самой линии контура, в которой 

располагается текст. Здесь можно выбрать ее вид и цвет. В закладке Runaround 

(Обтекание) устанавливается обтекание текста вокруг объекта. 

 

Гарнитура и текст шрифта 

 

Чтобы изменить гарнитуру текста, выполняем команду Style>Front 

(Стиль>Перед). Нужно еще выбрать начертание шрифта Style>Size>Other 

(Стиль>Размер>Другое) (рис. 2.17). 
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Рисунок 2.17 ― Редактирование шрифта текста 
 

В правой стороне окна выбираются нужные характеристики, такие как 

прямой, жирный, курсив, подчеркивание. Size (Размер) – ввести значение 

кегля. Весь дальнейший текст будет отображаться в соответствии с этими 

настройками. 

 

Интерлиньяж 

 

Это расстояние по вертикали между базовыми линиями двух строк. В 

программе это расстояние между базовой линии данной строки и базовой 

линии над этой строкой, которая расположена выше первой. Создаем текстовый 

фрейм, помещаем в него текст и выделяем его. Выполняем команду  

Style>Leading (Стиль>Интерлиньяж) (рис. 2.18). 
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Рисунок 2.18 ― Редактирование шрифта текста 
 

При выполнении настроек выделенная строка смещается от верхнего края 

текста. Активируйте вкладку Paragraph Attributes (Атрибуты абзаца). Это 

можно сделать в панели Measurements (Измерения) нажав на иконку 

параграфа (рис. 2.19). 

 

 
 

Рисунок 2.19 ― Вид интерфейса при настройке интерлиньяжа 

 

В поле Leading (Интерлиньяж) кнопками изменяйте значение 

интерлиньяжа (рис. 2.20). 
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Рисунок 2.20 ― Изменение значений интерлиньяжа 

 

Чем больше это значение установить,тем больше интерлиньяж. 

 

Керниг и трекинг 

 

Выполните команду Style>Track (Стиль>Трекинг) (рис. 2.21). 

 

  
 

Рисунок 2.21 ― Вид интерфейса при настройке трекинга 
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Изменяя этот параметр, изменяется расстояние между символами Track 

Ammount (Межсимвольное расстояние). Также настройки треккинга можно 

изменить во вкладке Character Attributs (Атрибуты символа) в поле ввода 

Track Ammount (Межсимвольное расстояние). Это можно сделать в панели 

Measurements (Измерения) (рис. 2.22). 

 

 
 

Рисунок 2.22 ― Изменение параметров трекинга 

 

Кернинг выполняется автоматически, и ручная подгонка, как правило, 

выполняется при подгонке текстов, набранных крупным кеглем. Нажмите 

Utilities>Kerning Table Edit (Утилиты>редактор таблицы кернинга), затем 

выбирается тип шрифта и подгоняется индивидуально. Трекинг и кернинг 

выполняют практически идентичные функции — они позволяют настроить 

расстояние между символами. Так в чем же состоит отличие? В области 

действия. Кернинг позволяет задать расстояние всего для нескольких символов, 

в то время как трекинг — расстояние между всеми выделенными символами. В 

QuarkXPress для доступа к этим параметрам используется одно и то же меню, 

поскольку их можно считать разновидностями одной и той же функции. Если 

курсор располагается между двумя символами, в меню Style (Стиль) вы 

увидите команду Kern (Кернинг), но если вы выделили несколько символов, 

то эта команда будет заменена на команду Track (Трекинг). Подобно этому 

кнопки со стрелками «влево» и «вправо» позволяют изменять кернинг, если 

курсор располагается между двумя символами, или трекинг, если вы выделили 

несколько символов. 
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Табуляторы 
 

Обеспечивают точное положение нужных символов в строке. При 

установке определенного значения табулятор будет оставаться в заданном 

положении в не зависимости от содержании текста в строке. Символы 

табуляции перемещают текст вдоль строки. А маркеры определяют действие 

символов табуляции. 

Создайте текстовый фрейм при помощи любого из способов и введите в 

него текст. Затем из пункта в меню Style (Стиль) выберите команду Tabs 

(Табуляция), появится диалоговое окно (рис. 2.23). 

 

 
 

Рисунок 2.23 ― Выполнение команды табуляции 
 

Существует несколько типов табуляторов в QuarkXPress по левому краю, 

по правому и т. д. Также можно производить выравнивание по знаку, который 

вы зададите сами (рис. 2.24). 
 

 
 

Рисунок 2.24 ― Задание параметров табуляции 
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Выберете один из табуляторов из верхней части палитры, далее 

перемещайте маркер на линейке над текстовым фреймом. Во время 

перемещения маркера программа показывает на экране вертикальный 

указатель, который следует за положением пиктограммы табулятора. Как 

только пиктограмма табулятора окажется в нужном месте, прекратите 

табуляцию. Изменения, произведенные вами, отобразяться на текстовом абзаце 

внутри текстового фрейма. 

 

Символьные стили 

 

Создадим стиль при помощи простого способа. Выделите текст, к 

которому хотите применить стиль. Затем в таблице стилей Style Sheets  

щелкните на правую кнопку мыши и в контекстном меню выберите вкладку 

New (Новый/Создать) (рис. 2.25). 

 

 
 

Рисунок 2.25 ― Создание стиля 
 

В появившемся диалоговом окне задайте имя стилю и выберите сбоку его 

характеристики, например курсив, жирный шрифт и поставьте галочку в поле 

рядом, также можно поменять цвет шрифта и т. д. Характеристики стиля 

заданы, нажимаем кнопку применить стиль <ОК> (рис. 2.26). 

Витебский государственный технологический университет



24 

 

  
 

Рисунок 2.26 ― Задание параметров стиля 

 

Стили абзаца 

 

Выделите абзац и нажмите правую кнопку мыши на палитре, и в 

появившемся окне выберите вкладку New (Создать/Новый). В появившемся 

диалоговом окне можете в поле Name (Имя) выбрать имя редактируемого 

стиля. Установите параметры нового стиля и нажмите <Ок> (рис. 2.27). 

 

 
 

Рисунок 2.27 ― Создание стиля абзаца 
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В стилях абзаца будет добавлен новый стиль. Теперь применим стиль 

абзаца, для этого выделим абзац или несколько абзацов и щелкнем по ним 

мышью. Чтобы сохранить стиль, используйте сочетание клавиш <Alt+Shift> в 

момент, когда вы производите щелчок на имени абзаца. Для удаления стиля 

используйте команду Delete (Удалить), при создании копии щелкните правой 

кнопкой по имени стиля и выберите вкладку Dublicate (Дублировать) (рис. 

2.28). 

 

 
 

Рисунок 2.28 ― Применение стиля абзаца 
 

 

3 Работа с цветом 

 

Основная работа с цветами осуществляется в палитре Colors (Цвета). 

Введите текст. В верхней панели в палитре Colors (Цвета) находится 3 

переключателя, они служат для объекта, с которым будет производиться 

работа, нажмите Text Color (Цвет текста) (рис. 3.1). 
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Рисунок 3.1 ― Работа с цветом текста 

 

Выделите часть текста. Для того чтобы изменить цвет текста, досточно 

выбрать пункт из списка, при этом выделенный текст сразу изменит цвет (рис. 

3.2).  
 

 
 

Рисунок 3.2 ― Текст с измененным цветом 

 

Для изменения яркости служит список Shade (Оттенок). Также можно 

изменить прозрачность текста в соседнем поле. Для изменения фона 

используйте инструмент Item Tool (Элемент), при выделении фрейма 
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происходит автоматическое переключение в режим Backgruond Color (Цвет 

фона) (рис. 3.3). 

 

 
 

Рисунок 3.3 ― Результат произведенных изменений 

 

Окно редактирования цветов 

 

Войдите в меню Edit (Редактировать), выберите в меню Colors (Цвета) 

(рис. 3.4).  

 

 
 

Рисунок 3.4 ― Вид интерфейса при нажатии меню Colors 
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Появится диалоговое окно редактирования списка цветов. При нажатии 

кнопки New (Создать/Новый) появится окно для создания нового цвета (рис. 

3.5).  

 

 
 

Рисунок 3.5 ― Интерфейс при создании цвета 
 
 

4 Некоторые дополнительные функции 

 

Вспомогательные линии 

 

Необходимо вызвать команду Rules (Направляющие линии) из пункта 

главного меню View (Вид). Сверху и слева появляются пересекающие 

направляющие, из которых можно вытащить пересекающиеся направляющие 

(Guides). Теперь нам нужно сделать страницы одинаковыми, мы знаем, что наш 

формат − это альбомный А4, значит делим его сторону 297 мм на три и 

получаем, что каждая страница нашего лифлета должна быть 99 мм. Из 

верхнего левого уголка выставляем нулевую отметку в левый край макета, 

затем выводим из вертикальной линейки, после того как появится пиктограмма 

с разнонаправленной стрелочкой Guides (Направляющую линию) (обычно 

зеленого цвета) и отпускаем его только тогда, когда он достигнет отметки в 99 

мм по горизонтальной шкале линейки. И еще один Guides (Направляющую  

линию) мы выводим опять из вертикальной линейки таким же способом, но 

уже на отметку не 99 мм, а  на 198 мм (потому что 99+99 = 198), таким образом, 

мы понимаем, что наш формат состоит из частей 99+99+99=297 (наш формат по 

горизонтали). Это один из самых простых способов разметки (линейкой и 

гайдами) (рис. 4.1).  
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Рисунок 4.1 ― Интерфейс с пересекающимися направляющими 

 

Изменение формы и размера объектов 

 

Войдите в пункт меню Item (Элемент) главного меню и выберите 

команду Shape (Форма) (рис. 4.2). 

 

 
 

Рисунок 4.2 ― Интерфейс при изменении формы объектов 
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С помощью инструментов Pen Tool (Инструмент Перо) и Select Tool 

(Выбор инструмента) можно видоизменять объекты (рис. 4.3).  

 

 
 

Рисунок 4.3 ― Видоизмененный объект 
 

Группы объектов 

 

Иногда удачно найденное сочетание объектов рекомендуется объединять 

в группы, чтобы избежать случайных сдвигов. Сгруппировать объекты можно с 

помощью команды Item (Элемент)>Group (Группа) (рис. 4.4). 

 

 
 

Рисунок 4.4 ― Сгруппированные объекты 
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Чтобы зафиксировать объекты, выберите команду Item (Элемент)>Lock 

(Привязать). 

Проверка орфографии 

 

Напишите текст, выделите его, откройте пункт меню Utilities. Далее 

раскройте подменю Check Spelling (Проверка орфографии). Вызовите первую 

команду для проверки орфографии (рис. 4.5).  

 

 
 

Рисунок 4.5 ― Проверка орфографии 
 
 

5 Работа с иллюстрациями 

 

Вставка изображения 

 

Следует выбрать  инструмент Графический блок (Picture Content Tool) 

из палитры Tools (Инструменты). Чтобы создать графический блок, 

необходимо выполнить те же действия, что и для создания текстового. Также 

можно преобразовать графический блок в текстовый (и, наоборот) с помощью 

команды Элемент (Item)>Содержимое (Content). Затем из вкладки 

Содержимое (Content) выберите значение Текст (Text) или Рисунок (Picture). 

Нажимаем на блок правой кнопкой мыши и выбираем Импорт (Import) 

для вставки изображения (рис. 5.1). 
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Рисунок 5.1 ― Импорт изображения 
 

Убедитесь в том, что графический блок является активным. Выберите 

команду Элемент (Item)>Изменить (Modify), чтобы отобразить диалоговое 

окно Изменить (Modify) или комбинацию <Ctrl+M>. 

Вкладки Блок (Box) и Рамка (Frame) идентичны для текстовых и 

графических блоков. 

Вкладка Рисунок (Picture) (рис. 5.2) позволяет изменять размер и 

положение графического блока, вращать и масштабировать его, изменять 

фоновый цвет и даже наклонять его. Единственное отличие графического блока 

от текстового состоит в том, что в нем позволяется изменять положение или 

кадрировать изображение в пределах графического блока. Если вы указали 

определенные значения на вкладке до импортирования графического 

изображения, то все заданные вами параметры будут применены к 

изображению. 

 
 

Рисунок 5.2 ― Вид интерфейса при изменении графического блока 
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Вкладка Обтекание (Runaround) позволяет задать параметры обтекания 

графических изображений текстом. Можно задать расстояние между текстом и 

графическим блоком, указав необходимые значения в текстовых полях. 

Вкладка Обрезка (Clipping) (рис. 5.3) позволяет указать, какая именно 

часть изображения должна быть видна в макете; для этого используется 

обтравочный контур. При этом изменения в исходный графический файл не 

вносятся; обтравочный контур оказывает влияние только на копию 

изображения, вставленную в макет. 
 

 
 

Рисунок 5.3 ― Вид интерфейса при обрезке изображения 

 

Изменение формы блока 
 

Можно создавать не только прямоугольную форму текстового или 

графического блока. Это мы рассмотрели в разделе Изменение формы и 

размера объектов. Еѐ можно также объединять и исключать с другими 

фигурами. Для этого расположите одну фигуру над второй. Объедините их 

клавишей <Shift>. Выберите Элемент (Item)>Слияние (Merge) (рис. 5.4). Там 

можно выбрать вид сочетания. 
 

 
 

 

Рисунок 5.4 ― Вид интерфейса при выборе слияния 
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Работа с масштабированием изображения 

 

Выбрав команду Стиль (Style)>Масштабировать рисунок по размеру 

блока (Scale Picture To Box), вы согласуете размеры блока и рисунка, не 

изменяя пропорций последнего. 

Выбрав команду Стиль (Style)>Блок по размеру рисунка (Fit Box To 

Picture), согласуйте размеры блока и рисунка таким образом, чтобы размеры 

блока были изменены в соответствии с размерами рисунка, а не наоборот. 

Чтобы поместить изображение в центр окна, выберите Стиль 

(Style)>Центрировать рисунок (Center Picture) (рис. 5.5). 

 

 
 

Рисунок 5.5 ― Вид интерфейса при масштабировании изображения 

 

Кроме того, вам предоставляется возможность вручную изменить 

положение рисунка или обрезать его, чтобы наилучшим образом согласовать с 

блоком. Для изменения положения рисунка в блоке сначала выберите 

инструмент Содержимое (Picture Content Tool). Потом щелкните на рисунке и 

перетащите его. При этом указатель примет форму руки. Отпустите кнопку 

мыши только тогда, когда рисунок окажется в необходимом месте блока. 

 

Настойка прозрачности 

 

Для этого выберите графический блок. Нажмите Стиль 

(Style)>Прозрачность (Opacity) и выберите необходимое значение (рис. 5.6).  
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Рисунок 5.6 ― Вид интерфейса при задании прозрачности изображения 

 

Обтекание 

 

Создайте на странице текстовый блок, который заполните текстом. 

Создайте дополнительный элемент, который и будет обтекать текст. Или же 

выделите необходимый элемент и воспользуйтесь командой Элемент 

(Item)>Переместить на передний план (Bring To Front), производится 

перемещение объекта на самый верх так называемой стопки, чтобы убедиться 

— элемент находится над текстовым блоком. Выберите команду Элемент 

(Item)>Изменить (Modify), после чего перейдите на вкладку Обтекание 

(Runaround) или воспользуйтесь комбинацией клавиш <Ctrl+T>. 

Убедитесь в том, что на вкладке Обтекание (Runaround) из 

раскрывающегося списка Тип (Type) выбрано значение Элемент (Item). Если 

необходимо отключить функцию обтекания, из раскрывающегося списка Тип 

(Type) выберите значение, Нет (None). 

Укажите необходимые значения в текстовых полях (в зависимости от 

версии) Сдвиг (Offset), Сверху (Top), Снизу (Bottom), Слева (Left) и Справа 

(Right), чтобы определить, насколько далеко должен располагаться текст от 

контура элемента. Если элемент имеет непрямоугольную форму, укажите 

значение только для параметра Сдвиг (Offset) (рис. 5.7). 
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Рисунок 5.7 ― Вид интерфейса при задании параметров обтекания 

 

Создание альфа-каналов 

 

Обтекание используется по умолчанию при размещении любого объекта 

над текстовым блоком. Также можно настроить обтекание не только по форме 

графического блока, но и по форме изображения. Это можно сделать как в 

QuarkXPress, так и с использованием других программ. Для этого в программе 

Photoshop выделите необходимый участок изображения и откройте палитру 

Каналы  (Channels) (рис. 5.8). 
 

 
 

Рисунок 5.8 ― Вид интерфейса при открытии каналов 
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В ней создайте альфа-канал, где будет белое изображение на чѐрном фоне 

(рис. 5.9). Таким образом вы можете создавать несколько альфа-каналов. 
 

 
 

Рисунок 5.9 ― Вид интерфейса при создании альфа-каналов в Photoshop 

 

Далее Файл (File)>Сохранить как (Save As). И при сохранении нужно 

поставить галочку на Альфа-каналы (Alpha Channels). Далее в QuarkXPress 

во вкладке Обтекание (Runaround) выберите Тип (Type)>Альфа-канал 

(Alpha Channel)  (рис. 5.10). 

 

 
 

Рисунок 5.10 ― Вид интерфейса при работе с альфа-каналами в 

QuarkXPress  
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Далее можно настроить обтекание изображения с помощью альфа канала 

(рис. 5.11), поставив галочки Только наружные края (Outside Edge Only), 

Ограничить блоком (Restrict To Box). 

 

 
 

Рисунок 5.11 ― Настройка  обтекания изображения с помощью  

альфа-канала 

 

6 Пример верстки трехполосного лифлета 

 

Нужно ввести Имя макета (Layout Name) (мы назовем его «Буклет 

Витебск») и указать Тип макета (Layout Type). Затем ввести остальные 

параметры (в зависимости от версии, некоторых может не быть или добавлены 

другие): Размер страницы (Size), Ориентация (Orientation) (альбомная или 

книжная), Направляющие полей (Margin Guides) (размер верхнего, 

нижнего, левого и правого поля), Направляющие колонок (Column Guides), 

Разворот (After Page) (для макетов, имеющих левые и правые страницы и 

одновременного их просмотра, например, разворот газеты или журнала), 

Автосоздание текстового блока (Automatic Text Box) – на всю страницу 

макета вводится блок для текста. По умолчанию настройки действуют на всех 

добавляемых впоследствии страницах макета и его Шаблонных страницах. 

Внести изменения в настройки можно через меню Макет>Свойства макета 

(Layout>Properties). Ориентация будет альбомная (Landscape) (рис. 6.1). 
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Рисунок 6.1 ― Настройка  параметров создаваемого буклета 

 

Создадим 2 страницы, одна из них будет с одной стороны, вторая − с 

оборотной стороны буклета. Выполните команду Page 

(Страница)>Insert(Вставить)<Ok> (рис. 6.2). 

 

 
 

Рисунок 6.2 ― Создание страниц буклета 
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Теперь у нас 2 страницы. Щелкаем одним кликом правой кнопки мыши 

по экрану, в диалоговом окне выбираем Импорт (Import) и импортируем в 

документ изображение, затем нажимаем Открыть (Open) (рис. 6.3).  
 

 

 

Рисунок 6.3 ― Импорт изображения 
 

Теперь наше изображение необходимо сделать нужного размера. Мы 

сделаем его подложкой документа и поэтому растянем его на всю первую 

страницу. Кликаем по этому изображению и растягиваем его маркеры до конца 

страницы, чтобы получилось вот так (рис. 6.4). 

 

 
 

Рисунок 6.4 ― Корректировка размера изображения 
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Теперь разметим (п.4 Некоторые дополнительные функции 

Вспомогательные линии), а потом создадим 3 текстовых блока  инструментом с 

буквой «Т» как на следующем рисунке (рис. 6.5). Разметка лифлета готова.  
 

 

 

Рисунок 6.5 ― Вид буклета после разметки с текстовыми блоками 
 

Аналогично работаем и со второй страницей. Теперь приступим к 

заполнению текстового и графического содержания буклета. 

1. Дадим заголовок буклету. Кликаем по 3 текстовому блоку и пишем 

заголовок. Выделяем текст, выбираем закладку Style (Стиль) и там есть все 

характеристики: Размер (Size), Цвет (Color), Прозрачность (Opacity)  и т. д. 

(рис. 6.6). 
 

 
 

Рисунок 6.6 ― Вид буклета с заголовком 
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2. Вставим изображения  для второй страницы. Тем временем текстовые

блоки устанавливаем на передний план страницы, чтобы они не потерялись: 

нажимаем правой кнопкой мыши по блоку, выполняем команду: Send and 

Bring (Отправить и переместить)>Bring to front (Переместить на передний 

план) (таким образом мы выставляем свои текстовые блоки поверх всех 

импортируемых изображений). Вот что у нас получилось (рис. 6.7).

Рисунок 6.7 ― Вид буклета с текстом поверх изображения 

Теперь можем добавлять все текстовое содержимое буклета. Выбираем 

«Т» из инструментов и нажимаем на блоки, пишем текст (рис. 6.8). 

Рисунок 6.8 ― Окончательный вид буклета с текстом поверх 

изображения
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В элементах управления открываем функцию File>Export>Layout as 

PDF (Файл>Экспорт>Сохранить как PDF) (рис. 6.9).

Рисунок 6.9 ― Сохранение буклета 

В зависимости от требований типографии, для дальнейшей печати, скорее 

всего, еще необходимо будет в этом пункте  File (Файл) нажать Collect for 

Output (Собрать для вывода). Лифлет  готов для печати в типографии. 
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